
Занятие 2. Пятая неделя.
Как работать с   OpenOffice Spreadsheets

После того, как соответствующая программа будет открыта, Вы 
увидите таблицу (Рис.1а). Сама таблица напоминает поле игры 
«Морской бой». Как и в морском бое, каждая клетка таблицы имеет 
координату, например А1 или C5. Но поле таблицы конечно много 
интереснее. Причина тому, оно по сути своей очень близко к памяти 
компьютера, которая тоже имеет двумерные координаты своих ячеек 
памяти. Также как и в памяти компьютера, в ячейках таблицы может 
сохраняться различная информация. Её можно посмотреть наведя 
курсор на соответствующую ячейку и кликнув левой кнопкой мышки.
Содержимое ячейки появиться в поле обведенном фиолетовой кривой
на Рис.1.а. И обратно, если мы выделим ячейку и  запишем в этом 
поле что-то, а затем 
нажмем на Enter,  то записанное сохранится в выделенной ранее 
ячейке. Что можно сохранить в ячейке таблицы? Числа, текст и 
функции. Таблица сама отличает десятичные числа от текста и от 
функций. Различает по простому принципу: то что состоит из цифр- 
это число. То что состоит из букв или любых знаков, но при этом 
первый знак '  (например, abc или  '123)- относится к string, т.е. 
текстовой информации.  Если первым стоит знак равенства =, то это 
табличная функция (например, =sum(A1:D1) означает функцию 
суммирующую числа стоящие в ячейках от А1 до D1: A1, B1, C1, и 
D1). Так же как и в памяти компьютера, в таблицах практически 
реализованы два типа адресации: прямая и косвенная. При прямой 
адресации, мы находим или сохраняем данные в ячейке с указанным 
адресом. Например, можем сохранить в ячейке А1 число 7. Для этого 
наведите мышкой курсор на ячейку А1 и напечатайте цифру 7. Потом 
нажмите на клавишу Enter, чтобы сохранить цифру в ячейке. Если 
теперь опять навести курсор на ячейку с цифрой 7, то и в поле 
значений Вы увидите ту же «7» (поле значений обведено фиолетовым 
эллипсом на Рис.1.а.). Это же поле значений используйте для 
редактирования/исправлений содержимого ячейки. 
Последовательность действий при редактировании обычная. Сначала 
выделяете мышкой с помощью курсора  нажав при этом на левую 
клавишу мышки то, что хотите исправить. Затем печатаете 
исправления. Того же эффекта можно достичь выделяя с помощью 
стрелок и одновременного нажатия клавиши Shift на клавиатуре. В 



случае косвенной адресации, по указанному адресу будут находится 
не данные или команда, а адрес ячейки, где находятся данные. 
Например, если мы запишем в ячейку В3 таблицы следующую 
«табличную» функцию (не забудьте нажать на клавишу Enter после 
того, как впечатали формулу): 
 = A1
 приравнивающую значение ячейки В3  значению ячейки А1, то 
ячейка В3 будет содержать адрес другой ячейки А1, где и находятся 
реальные данные. При этом в ячейке В3 мы увидим число 7,  но в 
поле значений будет =A1 (Рис.1.б).

а)

б)

Рис.1. а) Вид  открытого листа OpenOffice  таблицы. Обратите 
внимание таблицы содержат 3 листа. Открыт первый (обведено 
оранжевой линией). Название листа  Sheet1 можно 



отредактировать кликнув два раза на него и вписав желаемое имя
в появившемся окне; б) запись и чтение данных в ячейках 
таблицы. В обоих случаях сначала надо навести курсор на 
требуемую клетку таблицы. Затем кликнуть левой клавишей 
мышки. Этим Вы выделите клетку и вокруг неё появится 
утолщенная черная рамка. Например, на рисунке выделена клетка
В3. При этом значение клетки равно 7, а в поле значений видно, 
что в клетке записана функция =A1 , приравнивающая её значение
к значению клетки А1. Содержимое клетки можно изменить. 
Для этого можно либо просто напечатать её новое содержание, 
которое автоматически будет вписано в выделенную клетку; 
либо навести курсор на поле значений и кликнуть левой клавишей 
мышки, а затем выполнить необходимые исправления. Если в 
этот момент Вы передумали исправлять, то можно нажать на 
клавиатуре кнопку Esc. Этим Вы диактивируете клетку. После 
выполненных исправлений нажмите кнопку Enter, чтобы 
исправления в клетке сохранились.

Ниже приводится список других часто употребляемых 
табличных функций:
=power(a;b)  - означает выражение ab, например =power(2;3)  даст 23 

=8;   = power(8;1/3)  даст 2 . Обратите внимание, что в Excel таблицах 
компании Microsoft  числа разделяются просто запятой вместо точки с
запятой. Например, в Excel надо писать:  =power(2,3) . Задание 
значений a и b возможно с использованием косвенной адресации. 
Например :  =power(E3;F1) возведет число по адресу E3 в степень 
числа, находящегося по адресу F1.
= sqrt(a) – означает квадратный корень числа а. Например =sqrt(4)  
даст 2. Как обычно, можно использовать косвенную адресацию.
-Чтобы подсчитать произведение величин сохраненных в ячейках, 
надо записать через произведение адресов ячеек. Например, запись = 
A2*D3 подсчитает произведение данных в ячейках A2 и D3. 
Аналогично можно найти результат деления, сложения или 
вычитания:  = A2/D3 ; = A2+D3; = A2-D3. Если же у Вас есть числа 
которые просто надо сложить, например Вам надо сложить 23 и 45, то
это можно сделать записав =23 + 45.  Но обычно лучше сначала 
данные сохранить в ячейках, а затем оперировать ячейками используя



косвенную адресацию. 
=max (a:b)  – находит максимальное значение в ячейках с адресами с 
а по b. Например,  =max(C3:C5) находит максимальное значение в 
ячейках с C3 по C5 : C3, C4, C5 .
Аналогично работает нахождение минимума . Например, 
=min(C3:C5) найдет минимальное значение по тем же адресам.
=exp(a)  - находит значение экспоненты числа а или если а это адрес, 
то экспоненты числа стоящего по адресу а. Например: =exp(2)  даст 
7.39. 
=log(number; base) –вычисляет значение логарифма числа number по 
основанию base. Например, =log(100;10) даст два. Вместо чисел 
можно использовать адреса ячеек, где находятся числа.
=ln (number) –найдет значение натурального логарифма числа 
number. Как обычно, вместо прямой адресации можно использовать 
косвенную адресацию, т.е. вместо числа можно использовать адрес 
ячейки, где находится число.
= pi()  - вернёт значение числа . Обратите внимание на скобки: они 
пустые.
=sin (b)
=cos(b)
=tan(b)  - тригонометрические функции синуса, косинуса и тангенса. 
Размерность b –радианы. Как обычно,  b либо само число, либо адрес 
числа.
=аsin (b)
=аcos(b)
=аtan(b)  - тригонометрические функции арксинуса, аркосинуса и 
арктангенса. 
=DEGREES(b)
=RADIANS(b)  - переводит радианы в углы и наоборот углы в 
радианы. 

Пример для самообучения, в том случае если учебные видео вызвали 
затруднение:
 С помощью таблицы найдите значения функции y= 12.4 + 35x -13x2 
+ ex в диапазоне от 0 до 10 и постройте её график.  Для этого  
заполните таблицу, как показано ниже на Рис.2_Задание1. Ответ 
показан в колонке В, ячейки В2:В12, на Рис.2_Задание1.д.



 
а) б)

Рис. 2_Задание1. а) Заполните сначала таблицу как показано на 
рисунке и выделите с помощью мышки клетки A2:A3. Сместите 
курсор в правый нижний угол выделенной области. Когда курсор 
коснется угла он превратится в белый крестик (на рисунке 
выделен красным цветом). Нажмите в этот момент на левую 
клавишу мышки и тяните крестик вниз мышкой, не отпуская 
левой клавиши, до клетки A12. Отпустите клавишу и Вы должны
получить изображение показанное на рисунке б). Тот же 
результат можно получить если вручную набить числа в ячейки 
A2:A12.; в) Встаньте на клетку В2 и впечатайте формулу 
=B$1+C$1*A2-13*POWER(A2;2) + EXP(A2) (впечатывать можно 
прямо в ячейку или в поле значений ячейки). Затем нажмите 
наклавишу  Enter. Вы должны получить результат, как на рисунке
в); г)теперь надо скопировать только, что набранную формулу в 
ячейки с В3 по В12. Для этого выделив клетку, как показано на 
предыдущем рисунке, нажмите одновременно на клавиши Ctrl и C.
Этим Вы скопировали содержимое клетки В2 в буфер 
компьютера. Теперь выделите клетки с В3 по В12 и нажмите 
затем одновременно  две клавиши Ctrl и V. Этим действием Вы 
скопируете содержимое буфера в выделенные клетки. Получится, 
как на рисунке г). Тот же результат можно получить выделив 
клетку В2 и скопировав ее в клетки с В3 по В12 аналогично, как 
Вы делали на рисунке б). Клетки В2:В12 содержат искомый 
ответ;



в) г) 

Вы заметили, что вписали в ячейку В2 не совсем пока Вам понятную 
формулу =B$1+C$1*A2-13*POWER(A2;2) + EXP(A2). Назовем её 
исходной записью. Чем отличается адрес В1 от адреса В$1? Чтобы 
ответить, впишите в В2 формулу  =B1+C1*A2-13*POWER(A2;2) + 
EXP(A2) и скопируйте её в ячейки В3:В12 как Вы уже делали.  
Сравним результаты. Для этого, наведите курсор на ячейку, например,
В12 и посмотрите её содержимое в поле значений. Если в этот момент
наведете курсор на поле значений и нажмете на левую клавишу, то 
программа покажет разными цветами все ячейки, задействованные в 
подсчете значения. Само значение будет следующим: =B11+C11*A12-



13*POWER(A12;2) + EXP(A12).  Сравним его с аналогичным 
результатом в случае исходной записи:   =B$1+C$1*A12-
13*POWER(A12;2) + EXP(A12) (если Вы еще не успели сохранить 
изменения в файле, то для этого достаточно нажать на иконку Undo, 
обведенную на рисунке г) красным элипсом.  В противном случае 
Вам прийдется повторить шаги, начиная с записи исходной формулы 
в ячейку B2) . Вы заметили, что все адреса не отмеченные знаком $ 
изменили свои значения. Это произошло потому, что запись типа =В1 
дает не абсолютный (или фиксированный) адрес ячейки (который 
записывается как B$1), а относительный (или динамический), 
причем относительно той ячейки, в которую Вы его вписываете 
изначально. Посмотрите, когда вписывали формулу в ячейку В2, то 
написали В1. Это клетка находится наверху от клетки В2. После того, 
как формула была скопирована в В12, Вы получили слагаемое В11, 
которое опять же на одну клетку выше клетки В12. Если же Вы 
ставите знак $ перед 1, то компьютер теперь знает, что 1 будет 
фиксированной координатой и он не меняет её при копировании в 
другие ячейки. Но заметьте, координата В так и осталась 
относительной, поскольку перед ней нет знака доллара. Ошибки с 
колонкой не произошло только потому, что колонка у исходной 
ячейки В2 и ячеек, куда скопировали В3:В12, одна и та же- колонка В.
Если бы Вы скопировали в соседнии колонки, то опять бы получили 
ошибку, в чём легко убедиться. Поэтому, если бы решили копировать 
в соседнии колонки, то перед координатами всех колонок надо было 
бы тоже поставить знак доллара, чтобы сделать их абсолютными. 
Когда нужны абсолютные координаты, Вы теперь знаете. А когда же 
нужны относительные? Наш пример иллюстрирует ответ и на этот 
вопрос. Координаты строки переменной х из колонки А должны быть
относительными. Догадайтесь сами почему.

Построим теперь график функции  y= 12.4 + 35x -13x2 + ex . Для 
этого встаньте желательно на свободную клетку, например Е3, и 
нажмите на иконку с графбарами (Рис.1а, обведена зеленым 
эллипсом). Появится окно Chart Wizard,  показанное на Рис. 1_ 
Задание2, которое поможет в построении. В принципе окно само 
достаточно хорошо объясняет, что нужно делать. Поэтому только 
вкратце опишу необходимые шаги. Всего рекомендуется сделать 4 
шага: 1). “Chart Type” -Выбрать тип графика (очень важный шаг); 2). 
“Data Range” - Выбрать колонки (или строки), содержащие данные, 
которые будут использованы для построения графиков (этот шаг 



важен только, если надо построить 3 и более графиков); 3) “Data 
Series”-  Задать пары Х и У для каждой кривой, которую хотите 
построить (этот шаг очень важен) и 4). “Chart Elements” - Определить 
комментарии к графику и кривым.  Переходить с одного шага на 
другой можно нажимая Next (выделен линией малинового цвета) или 
просто выделяя нужный шаг в колонке “Steps” (обведена линией 
зеленого цвета).

Сначала выделим желаемый тип графика. Выберем тип «точки и 
линии»-  “Points and Lines”. Нажимаем Next. Следующее окно 
показано на рисунке б). Поскольку данных мало, то компьютер сам 
правильно определил, в каких ячейках мы сохранили их. Можно было
бы сразу перейти к следующему шагу, но можно и немного уточнить 
установки на этой странице. Сейчас нам надо только подсказать, что в
первой строке сохранены параметры, которые мы не будем 
использовать при построении кривых. Для этого переопределим “Data
Range”. Нажмем на кнопку “Select data range” очерченную красным 
элипсом. После чего получим доступ к таблице. Выделим мышкой 
(как обычно курсором + левая клавиша) область А2:В12. После этого 
программа сама вернет нас в Chart Wizard. Редактировать можно 
самим непосредственно в полях сообщений появляющихся окон. 
Тогда, чтобы вернуться в Chart Wizard надо самим же нажать на 
иконку справа аналогичную выделенной красным эллипсом. Теперь в 
поле Data range будет $Sheet1.$A$2:$B$12. Эта надпись означает что 
мы определили, что данные сохранены на Листе 1 в области: 
$A$2:$B$12 (как Вы уже знаете, это абсолютные адреса). Затем 
нажимаем на Next и переходим на страницу “Data Series”. Поскольку 
область данных была задана правильно и данных мало, то компьютер 
сам правильно определил кто есть Х и кто есть У. В случае же если 
Вы хотите изменить какой  нибудь параметр, надо просто выделить 
этот параметр. Например, мы решим изменить область определения. 
Значит надо выделить X-values ( Рис 1_Задание2.в) и 
отредактировать его либо в поле значений параметра Range for X-
Values  (обведен малиновым цветом на Рис.1_Задание2.в), либо 
нажать на Select data range этого поля и выполнить действия 
аналогичные совершенным при переопределении Data Range. Если 
мы хотим добавить график, то надо нажать на кнопку Add, а если 
удалить- то на  Remove. При нажатии на Add в поле Data ranges 
появятся параметеры Name, X-Values, Y-Values, которые необходимо 
определить спомощью той же  процедуры редактирования поля 



значений параметра. По завершению настроек  шага Data Series надо 
перейти на шаг Chart Elements нажав на Next. Последний шаг 
досточно очевидный. Вам 
предлагается назвать оси графика, указать хотите ли чтобы была сетка
на графике, указать названия линий и самого графика. Впишем 
названия осей и название графика и субтитла, как показано на 
Рис.1_.Задание2г. Отметим, что хотим, чтобы показали сетку по осям
X и Y. На этом редактирование графика закончено и можно нажать на 
Finish. Вы получите график показанный на Рис. 1_.Задание2д. 
График можно редактировать. Для этого надо навести на него курсор 
и кликнуть левой клавишей два раза. Это переведёт график в режим 
редактирования. После чего

а)



б)

в)



г)

д)

Рис. 1_Задание2. Построение графика (пояснения даны в тексте)

 надо выделить обьект, который Вы хотите исправить и кликнуть 
опять два раза левой клавишей. Или навести курсор и кликнуть 
правой клавишей, а затем выбрать из предложенного списка обьект 



для правки. Вновь появившиеся окна предложат Вам на выбор 
параметры обьекта, которые можно изменять. По завершении 
редактирования, как обычно нажмите на OK. График можно 
копировать. Для этого наведите курсор на график и кликните один раз
левой клавишей мышки. После нажмите на Ctrl и C одновременно. 
Теперь выберите ячейку в таблице, выделите ее и нажмите на Ctrl и V
одновременно. Вместо клавиш Ctrl и C можно наведя на график и 
кликнув один раз левой клавишей, затем кликнуть раз правой. 
Появится список из которого выберите Copy. Затем определив место 
для копии, выделив ее, опять кликните правой клавишей и выберите 
Paste.

В верхнем поле таблицы расположены меню. Если Вы наведете 
курсор на любое из них и щелкните клавишей мышки, то меню 
развернется и предложит Вам ряд опций. Например, если развернуть 
меню Tools, то получится как на Рисунке 2.а. На первых порах Вам 
особенно пригодится меню Help (обведен синей линией на Рис.1.а), 
где найдете ответы на все вопросы связанные с использованием 
таблиц. Например, полный лист функций Вы можете найти в меню 
Help>OpenOffice.org Help или нажав на клавишу F1, а затем открыв 
закладку Contents  и потом раздел Spreadsheets/Functions Types and 
Operators.

Format -другое важное меню. Оно позволит Вам поменять 
размер ячеек ( Format> Row , Format>Column), определить взаимное 
расположение нарисованных объектов (Formst> Arrange), 

а)



б)
Рис.2. а)  вид развернутого меню; б) вид открытого окна 

Customize для редактирования toolbars (другие закладки этого окна
позволяют редактировать меню, клавиатуру и кодировать 
события).

сгруппировать нарисованные объекты (Format>Group). Поскольку 
числа записанные в ячейках могут означать как просто число, так 
время, или стоимость, то чтобы компьютер правильно понимал кто 
есть кто, существует опция форматирования ячейки. Для того чтобы 
определить формат ячейки, выделите желаемую/желаемые ячейки 
курсором и откройте затем  меню Format>Cells… . Там Вы можете 
выбрать наиболее подходящий формат для Ваших ячеек. 
Поэкспериментируйте и определите предназначение остальных меню.

Ниже поля с меню, находится поле с ToolBars. Каждая иконка в 
этом поле представляет из себя определенную операцию (или 
макрокоманду).  Вы уже использовали некоторые из них. По 
изображению иконки легко догадаться какую операцию она запускает.
Если наведете курсор на иконку, то появиться текст поясняющий, для 
чего именно предназначена эта иконка.  Иконки и меню можно 
редактировать (удалить или добавить по вашему желанию). Для этого 
надо зайти в Tools>Customize. Перед Вами появится окно Customize. 



Откройте например закладку Tools. Затем в поле Toolbar выделите 
группу  Text Formmating и нажмите кнопку OK. А в поле Commands, 
отметьте Underline: Double (Рис.2.б). Теперь нарисуем, например, 
прямоугольник. Для этого сначала нажмите  на иконку с карандашом 
рисующем линию, чтобы появились toolbars для рисования (Рис.3, 
обведена красной линией). Выделив иконку прямоугольника (на 
рисунке обведено зеленой линией), нарисуем прямоугольник на 
таблице. Теперь впечатаем в него текст. Для этого сначала выделим 
нарисованную фигуру наведя на неё курсор и кликнув левой 
клавишей мышки. После того, как фигура будет выделена , впечатаем 
текст, например, string. Выделим теперь впечатанный текст и нажмем 
на появившуюся иконку Underline: Double (обведена желтой кривой). 
Вы увидите, что выделенное слово подчеркнётся  двумя линиями 
снизу.

Рис.3.  Показано, как нарисовать прямоугольник и впечатать в 
него текст дважды подчеркнутый снизу: шаг 1 (красный эллипс)- 
выделить иконку Показать функции рисования»; шаг 2 (зеленый 
эллипс) - выделить среди функций, функцию рисовать 
прямоугольники; шаг 3 (фиолетовый эллипс)-  нарисовать 
прямоугольник; шаг 4 –впечатать текст, например, string; шаг 4 
(фиолетовый эллипс)-  выделить текст наведя курсор на первую 
букву и, нажав на левую клавишу мышки, провести курсор по 
тексту. Вы увидите, что текст выделен прямоугольником, 
закрашенным другим цветом; шаг 5 (желтый эллипс)- нажмите 
на toolbar Underline: Double. Вы увидите, что выделенный текст 



стал подчеркнутым снизу двойной линией.

Чтобы сохранить Ваши изменения, рисунки, тексты и данные в 
памяти компьютера, откройте меню File (Рис.4а), и нажмите на 
опцию Save  или Save As (вторая в случае, если решили присвоить 
файлу новое имя или формат). Как гласит надпись справа от опции, 
того же результата можно достигнуть нажав комбинацию 
соответствующих клавиш. Например, вместо того, чтобы открывать 
меню, искать функцию Save, и нажимать на нее, Вы можете просто 
нажать одновременно на клавиши Ctrl и S. Или нажать на иконку 
указанную слева от команды. В данном случае это иконка с 
изображением гибкого диска. Во всех случаях перед Вами появиться 
окно, которое предложит ввести имя для Вашего файла содержащего 
Ваши данные, и  выбрать место, где Вы его сохраните (Рис.4б). 
Выберите сначала папку, где хотите сохранить Ваш файл. Например, 
My Document (обведен фиолетовым эллипсом). Затем вы 
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Рис.4.  Показано, как сохранить содержимое и установки 
таблицы (пояснения даны в тексте).

можете сохранить файл прямо в My Document, или создать, или 
выбрать другую папку вложенную в My Document. Если это уже 
существующая папка, то просто кликните на неё и открыв, сохраните 
файл. Если решили завести новую папку, то нажмите иконку папки 
(обведена линией голубого цвета. Иконка будет активирована, как 
только Вы зайдете  в My Document). После чего , Вы можете изменить
имя у вновь появившейся папки. Если этого не сделать сразу, то 
изменить имя или удалить папку можно будет потом с помощью 
системного мэнэджера, например для Windows- это Explorer. После 
того, как выбрали или создали папку, Вы можете присвоить файлу 
имя, впечатав его в поле обведенным зеленым цветом. Теперь 
осталось нажать на Save и Ваш файл сохранен.

Аналогично можно открыть ранее созданный файл. Надо только 
использовать опцию Open (обведена зеленым эллипсом на Рис.4а). 



Или создать новую таблицу (опция New обведенная линией синего 
цвета).


